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QGIS Tutorial for Agrometeorological Practice
Organized by Dr. PAEK, Doojin and Dr. LEE, Seongkyu

Dr. PAEK, Doojin (Seoul Housing and Community Corporation), 1002jeen@daum.net

Dr. LEE, Seongkyu (APEC Climate Center), geolegend@apcc21.org

Anyone who is interested in GIS application for Agro-meteorology and this
program is for beginner and low intermediate. It will be a good starting point
for those who want to know how to apply climate/weather data with GIS tool to
their own fields, especially agriculture field.
Prerequisite The following items must be brought to the tutorial session :
1. His/her own notebook computer
@s)111=119 | The detailed programs are as follows:
1. GIS training beginning — 1
- Introduction for OSGEO Korean Chapter
- Introduction for FOSS4G (Free and Open Sources Softwares (FOSS) for
Geospatial
- Overview of GIS (Geographic Information System)
- QGIS installation: program and example data
2. GIS training beginning — 2
- QGIS' practice : introduction for GIS data (vector & raster etc)
3. GIS training intermediate — 1
- QGIS spatial analysis I
4. @IS training intermediate — 2

- QGIS spatial analysis II with agrometeorological example

The contents may be subject to change without notification. The text book and
sample data for GIS tutorial will be distributed in the tutorial session. Dr.
CHUNG, Uran (APEC Climate Center) will support agrometeorological practice.
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Introduction to QGIS

- Using QGIS and ISCGM Global Map -






~. Korean Chapter

27 05Geo

Introduction to QGIS

- Using QGIS and ISCGM Global Map -

Doojin Paek(1002jeen@daum.net)

g

l. Overview -
QGIS
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I-1. QGIS Overview

O QGIS > Free & Open Source Geographic Information System

I. Overview — QGIS & Global Map

Release Date Version Codename
Jul-02 0.0.1-Alpha Start!!!
- 3 My 08 01 o
21-Jul-08 0.11.0 "Metis"
= MS Windows 5-Jan-09 1.0.0 "Kore"
= Mac OSX 1-Sep-09 1.20 "Daphnis"
= Linux, Unix 10-Jan-10 140 "Enceladus"”
29-Jul-10 1.5.0 "Tethys"
27-Nov-10 1.6.0 "Copiapd"
19-Jun-11 1.7.0 "Wroctaw"
21-Jun-12 1.8.0 "Lisboa"
8-Sep-13 2.0.0-2.0.1 "Dufour”
= GPL 26-Feb-14 2.2 "Valmiera"
27-June-14 24 "Chugiak"
31-October-14 2.6 "Brighton”
20-Febrary-15 2.8 “Wein"
26-June-15 2.10 "Pisa”
» C++, Python, .. 23-October-15 2.12 “Lyon”
29-February-16 2.14 “Essen”
08-Jul-16 2.16 “Ngdebo”

I-1. QGIS Overview

l. Overview — QGIS & Global Map

QGIS QGIS

Desktop | Browser

» Desktop GIS for
querying, creating,
editing, analyzing
geospatial data

> Browser for spatial data

» Web Mapping
Framework based on
QGIS Server and GeoExt

» WMS 1.3.0, 1.1.1 Server
» FastCGI/CGI Program
» SLD Support
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II. Installing
QGIS

lI-1. Installing QGIS

Q Install QGIS Essen (2.14.5, LTR Version) on Windows OS
@ Download latest QGIS Standalone Installer Version 2.14 from http://www.qgis.org/

@ Save the File to your machine and double click on the .exe file to install
3 Accept the install defaults to complete the process
@ Launch QGIS

Il. Installing QGIS

Eszen (2.14.5).

computer.

Click Mext to continue.
QGIS 2.0

support QGis|

This wizard will guide you through the installation of QGIS

It is recommended that you dose all other applications
before starting Setup, This will make it possible to update
relevant system files without having to reboat your

[ # Qais Essen (2145) Sem [ I
7 1 i b, | )
@ r" . o [
LA 1 ¢ Welcome to the QGIS Essen
4! (2.14.5) Setup Wizard

Donate

[tz ] Lomai | |
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Il. Installing QGIS

II-1. Installing QGIS

O Change the language setting/interface of QGIS

@ Launch QGIS

@ [EE] > [E4..]> [2EFE] > [US. English] > [=2]]

3 Select [Setting] = [Options...] menu and Select [Locale] - [U.S. English] & [OK]
@ Restart QGIS

¥ Duerride system locale

|
Ch4l AH2% Ctof 3.5, English -l
Naote: Enabling f changing override on local requiras e i ]
7 as

B AAOIA SRS Ao ko kR

2 Authentication

ECRTEE [ =2 [ se |[ cs2 |

lll. Using QGIS
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lll. Using QGIS

I11-1. QGIS GUI

U GUI Components

@ Menu bar
@ Tool bar E gy Bughs et s Deaace” b Brocesing” il
. b VETARAGL@AGLV. S A FHEAGEAE

@ Layer List P /BB mp~o O £ & 0BG R PER® YO
@ Map View EOSEL,AHPOLSR A g O [

[ EETAS
® Overview o e JE

« [ 0 portpler
® Status bar S ek .

L/~ 1R P

# o airp kor

-L#-I.".uulmv

PR T S B S

W B . 5
166013446031 sak  12:016 - ) Render | ersces (@ (]

lll. Using QGIS

I11-2. QGIS Toolbar

0 Customizing toolbar

Poject Edt Vew laper Setings Bugins Veclor Raster Defabase Arakss Hep

AR R@ESLALARP PR %A@ PN - = O-|| (X Advanced Digitizing

pEH-H-REEES-P S EA- /B R g 0L<E B o RG G - @Attributes
e BE | R e e — |

Right-click on empty gray part of TOOLBAR area | Database
% Digitizing

%/ File

[@51] ceoranzee: | GESESI 527404 | scte 12327295 = || 57| % mender ||z Izl HE'FI

% Label

% Manage Layers
Mo DEARRD A@e L - =- O-|| X Map Navigation

eeRGR - || Plugins
| | Raster

[ ] web

Database  Arabes  Help

@mmm| 407230, 5609251 | scte |[1230547 = || 57| % mender |[Erscimes
10

QGIS Tutorial for Agrometeorological Practice | 13



Korea Metecrolegical National Institute of
Administration Meteorological Sciences

@ Selecting CRS
Creating a New Shape File
Adding a New Feature

How to Use Field Calculator

©® e e

Labeling

Q Skills to Learn from This Chpater

I1l-3. Working with Vector Layer

lll. Using QGIS

Q Start with Selecting CRS

@ Enter "5174" in "Filter"” Field
3 Select "Korea 2000 / Unified CS

l1I-3. Working with Vector Layer

@ Click on the CRS Status Icon in the Lower Right-Hand Corner of the Status Bar

lll. Using QGIS

@ EPSE 432 (OTF)

x Enabln ‘sa tha By’ CAS wasciormasian
Fiker G179

Fecently used coandinak rakeanca systers

il
Selected CRS! [ Karea 2000/ Uniied (5

+init3=m N0

Caprdnate Rekence Bystem fatharity 10
1 7]
Cooecinals rHBEACE SYEaME af e Wik Hide deprecated CRgs
Canrdinate Aekrence SYEEm sy 10
= Prajected Coordinate Syatems
Tl e o EPORSITY

+praj=merc 4 30 +han_IE127,5 =0, 5696+ 0=1000000 4 _0=2000000 +elip5=GASH] +wgsi=00.0,0.00.0
dats

|| Concal Hoply Hsin
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lll. Using QGIS

I1l-3. Working with Vector Layer

O New Shapefile Layer

r]’ Mew Shapefile Layer [ER==)

Type

Add a New Field Named “High" 0 (Rl Line Pelgen
. " " Fil di Syste

Add a New Field Named “Low e eneadng L

EPSG:5174 - Koraa 2000 / Uniied C3 =
Click "OK" and Save Layer as "temperature” New field

Mame |High |

@ Layer > Create Layer > New Shapefile Layer...

® e

Type  Decimal number -

Length 20 Precision 10

147-sua]

\";; Edi Wiw [Layer] Sefings Fhugine ‘aci Beskr Dalabase $ab MMOGE Progessing Hib
D B R I __  leseeeeeeseeeeeeb U
Embed Liars and Gropr... A Fields list

. e £2 D nw G o Ll _

Q : |I!‘\élame l;(v;;er |\[§nglh |Precwsmn

Vo la 5

»

ﬂ 3 Pﬁmm\:rl.hvut\inwv CH+D

£ Ty

[ |G
Cancel Help
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lll. Using QGIS

l1I-3. Working with Vector Layer
O Add a New Feature
@ Click on the "Toggle Editing” Icon ~
@ Click on the "Adding Feature” Icon (\ ,‘

. 7 =
® Click on Any Place on the Canvas ( . 1

\—l
@ Fill in "id", "High" and “Low" Fields
® Add 2 More New Features on the Canvas (3 New Features Total)
® Finish Editing by Clicking on the “Toggle Editing” Icon and “Save” (’-\‘
When a Prompt Window Pops Up ~=/
A qeis 2147-Essen [N 077 temperaturs - Fzaturs Attributes R
Project Edit Miew Layer Setings F [ e o T e "

EHERR - o a

1

1

1

p . 1 High |29 all
EEIALY, » e =
Qe ]

Layers Panel

,m U_@E'
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lll. Using QGIS

I1l-3. Working with Vector Layer

Q Field Calculator
@ Right Click on the “temperature” Layer on the Layers Panel
@ Select "Open Attribute Table”

3 Click on "Open field calculator” Icon

E5sen = < Features 1053 3 filerect 3 galected: 0 2™
Project Edit “ew Layer Sebings Pluging “ecir Haster Datahase = P =1
> =) £ dm = | - (
= SO p o e | m High Low ~’
LRI Y - [ |
I_ 2/ 2A0000000000) TR0 000
|
@ w 2 3] 200000000000 130000000000
Lewers Panel e [
Aa .
o (@ ® T -3 B0
"5 57 Zoom to Layer
':: Shew in Overview
f L Remove
= L Duplicats
! Set Layer Scale Visibility
Set Layer CRS
q Set Broject CRS from Layer
) e ’
] B Open Artribute Tble
@: J Tagle Editing
@ Save As
- Save As Lave
=, I
Wy Eilter | T Show Al Featursa
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lll. Using QGIS

l1I-3. Working with Vector Layer

O Calculate Growing Degree-Day for Rice (Baseline = 10°C)
@ Fill in "Output field name" as "gdd”

@ Select "Output field type” as "Decimal number(real)”

® Input “10" into Precision Field

@ Type in a Formula for "gdd”

r
7 Field calculator 2 B E 7 »

[J Only update 0 selected features

% Create a new field —— Update existing field

Create virtual field

O_LnELFﬂ_eETyEe_— Decimal number Creal) - i
Qutput field \engthL—W_E::} Precisio -_-lu-_-_:lﬁ
Expression | Function Editar
P (S S 2 (S B T S ] ||#n’ Search
{ "High" + "Low" )2 - |0 Enn\iunFnumher

Canditionals
Conversions

NEpEEE
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I1l-3. Working with Vector Layer

O Field Calculator - Result

@ Right Click on the "temperature” Layer on the Layers Panel
@ Select "Open Attribute Table”

3 Click on "Open field calculator” Icon

lll. Using QGIS

-
/| temperature = Features total: 3, filtersd: 3, selected: 0
y . TR - * T =
HLEEIER IR -
id =[]
id High Low gdd
0 I &b, l0000nn0ad 15, 0000000000 10, 0000000000
i 2 29, 0000000000 16, 0000000000 12, 5000000000
............ -
5 3 15, 0000000000 4 UUUUUUUUUUL -0,5000000000 I
The Result Can be
Below "0”
17

l1I-3. Working with Vector Layer

0 Updating Existing Field
@ Click Again on "Open field calculator” Icon
@ Check "Update Existing Field"

3 Change the formula Using "Max" Function in "Math” Section

lll. Using QGIS

-Color
-Conditionals
Conversions
Custom

Expreszion | Function Editor

rlong

m
e and Time
= Halda and Valugs
* Rezy Maiching
7 ianen
3 I380m

e

ahn
acnn
asn
s

| max( ( "High" + "Low")/2 - 10,0) |

tlamp
co
dugraaz
aip
Aaar

n

A T—

| FRatums the largestvalue in 2 setol
— values

e
Azt Examples
cal '

-Date and Time
Fields and Values
-Fuzzy Matching
-General
Geometry

Math

-Operatars

Record
-Reference

- Strin
Timnel

aleiolatolaloiallclallall)
£

Use "Recent” Function
To Bring up a Recently
Used Formula
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O Result

I1l-3. Working with Vector Layer

lll. Using QGIS

-

_'f,, temperature - Features total: 3, filiered: 3, selected: 0  E—— E@gﬂ
Br|BE® & RES P EERE t
mid [+]-[£] - |[Update A [ Update Selected
id High Low gdd
0 | 26, (00000a0ad 15, 000a00naoa 10, 0A0a000000
1 2 29, 0000000ad 16, 000A0a0a00 _I_E;EJ_U_LIELI_LIEU_UL.I“ .
2 3 15, (000000000 4,0000000000 {1, 0R00n00000 i

Q Labeling
Select "Properties

Hlossz

- b

Coersien Panel

"

@ pe s

% [ ==

& Zoom to Layer
how in Overview
[1 Esmme
2 Deplicate
ot Layer Scale Visbilty
et Layer CRS
Set Eraject CAS from Layer
Stes
B Open Atriute e
Tagge Edring

v An

-

‘Save &x Layer Definticn Fle.

Edter
Show Featlre Count

Fapams

kst E0l MYew Lwwer Ganings Flugis Verdr Hoslr Datebasa Wab MM
B Y @ 4 ol d
ﬂ 2% 5N P ol o

l1I-3. Working with Vector Layer

Right Click on the “temperature” Layer on the Layers Panel

lll. Using QGIS

“Labels” > "Show labels for this layer” > Label with "High" - "OK"

- lempetEIurE | Lagek = AN -
|
= how Iabgle 1or e lager ‘ )y ‘3
Label wity 1 H N ' -
15 High ) 3
 TewtfBubfer samale =
Loem psurs =
Lararm Ipsum '; por 'I
v Tait Tout sl
" Fomatig .
N Fant, =8 aE
e Bufier =
W Backoound | 54 -
) Shadow — — — I
Mmtadata 5+ Placemert &5 a 7 & &
/ Renderig -
“ariables Sire 400 =re
Points ‘:L
Color [ s a
Trnsparancy [F s =P
Typecase | Hochange &
Spacing lakar | 0,0000
wend | 000000
. v
Sla -

18 | QGIS Tutorial for Agrometeorological Practice




I1l-3. Working with Vector Layer

O Result

LSRR
Project Edit Vew Lawer Setinge Plugine Veotr Faster [nbbore Web MMOIGE Progeesing Heo

H R G0 E

+

5 0 o ~ B~ B~
g PRHPPARR Be-H-&-§

NN Y Y

Leggers Pares|
-
* lamgsratun

]

Cank

~

&

R+ EOELPEHSAMNINSNAS 08 D

Coordinate (LTI T

21

: LEEY =
. ARGOR

lll. Using QGIS

Cank

20

\-—’

B Scole | (ALTE  + ) Fation 00 * WFendee @EPSEHETOTR @

l11-4. Interpolation

Q Skills to Learn from This Chapter

@ Capturing Coordinate
Calculating Distance from Field Calculator
Using Field Calculator Built-in Functions

Built-in Interpolation Tool

©® O

How to Style a Raster Layer

22

lll. Using QGIS
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lll. Using QGIS
l11-4. Interpolation

Q Constructing new data points within the range of a set of known data point

Laver Sedirgs Plugns Vectpr Rester [iabbaze Web MMOGE Progessing Help =}

H R 4R HPRPQ AR e -H-8-GEEYE s~ = EH W
Y /B ERRERES HFEE ARGOG

Layers Farel &

B+ BFOELAH38MFNANS 0@
g
i
i
A\
Lo |
-
E
~
I4
\
~

7=y
( g5 1
N
B
.
Caordinate (LTI T | Scale | 1WTTEE  « Fotbon 00 < Ferder @ EPSEHETIOTR @
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lll. Using QGIS
l11-4. Interpolation

O Constructing new data points within the range of a set of known data point

0 Unknown
e - Extrapolation
Unknown S | Known I
- Interpolation | -

24
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l11-4. Interpolation

Q Constructing new data points within the range of a set of known data point

lll. Using QGIS

l11-4. Interpolation

O Constructing new data points within the range of a set of known data point

lll. Using QGIS

26
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l11-4. Interpolation

lll. Using QGIS

The First Law of Geography

"Everything is related to everything else, but
near things are more related than distant
things. — Waldo Tobler

a IDW
L]
\
\
\
\
\
\
\
\
\
\
\
\
\
\
: X
IStance

-
-
-~
e ———
-

Distance

27

l11-4. Interpolation

Q IDW

7N
ol
\—’

lll. Using QGIS

N j====y

Z:'w@(x: i
j=lb=—=m . )
!4X}= N b ﬂdﬁﬁxﬂaﬁﬂﬂnzﬂh
Z w;(x)
i=1
iy if d(x,x;) = 0 for some i
where
1
i(X) = rem=====n
e 1d(x, ;)7

28
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. Using QGIS
l11-4. Interpolation

O Capture Coordinate of the Unknown Point
@ Vector » Coordinate Capture - Coordinate Capture
@ Click on the Canvas Where the Unknown Point Located
3 Copy the Coordinate

Coordinate Capture =]
Hagter [atabazs  Web MMCGIS Propessira  Helr
Y [ LN - BN Coondinate e
BRLE & O D -
PE—— o aes . 126,34034,34,87210
./ B o e "0 /R M| Gouses R R
DpanSiaetap
Q ¥ Fioad graph v ittt ——— 1
Spatial Quary N — [ 1| a4ea50, 262, 1653157, 848 I
Laers Ransl Tabla Manager . [ ]

d &= T eE>F XL Topalogy Checker
& fnalysiz Tools
g Resesrch Toals

v
© % e temperalure .
£} Geaprocassing Teals v
v
v

Copy to clipboard

4B Gaometns Tools

Va
L
ﬁj = Data Managament Toals
@

- Start capture

29

lll. Using QGIS
l11-4. Interpolation

O Calculate Distance Using Field Calculator
@ Open Field Calculator
@ Create a New Field “distance”

® Convert Copied Coordinate to WKT(Well-Known Text) - 'Point(948850 1653187)

J Faid

i, 5 SOSBE® o 0 sssas . e a Coordinate Capture =]

® Create a new fiekd Update existing Seld
Craak itud neld

Ottt vame (G 26,3403, 34, 57210

Cutputfiald ype  Dacimal numbar (mal) -] H

| Outpefiald langth (103 Pracklen (10 %

Exprazzion |_Funeian Edbar
= 2 B T R

"pain 2 Fuzzy Maihing
Generl

Gaamey
i ] Copy to clipboard
L o p

e —. Start capture

Ouput pradaw: Pairtl MBFED 1GE3IETY

30
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lll. Using QGIS
l11-4. Interpolation

O Calculate Distance Using Field Calculator

@ Convert WKT to Geometry > geom_from_wkt('Point(9488850 1653187)")
(Now, the Field Calculator Can Identify “X")

£ Fislc caoulater S8 BB 5 - -

™ Creste a new fiekd Update existing field
Creak itudl fiefd
Cutp il rams | ditence

Cutptfiald ps | Dackmal numaar fraal] -] “
Cutptfiald kangh (10 (3| Prackion (10 5
Evprazzian | Funcian Edior | fn)\__\ ‘,,,-—-‘I‘:»’
PR I A | [ T | S’ Tl L
guom_tram_ il poize panzan 1emaiaT) ) = T T

e . o

funds S -

untz_hai . -

e PRIl NP

sariar X

conkuid
closest_point
cambine

inleriarsing_n
Pesacian
Inferzact
inerzacts ooy
bicloaa

51 W

Pt praviaw; e cmeny: P

31

lll. Using QGIS
l11-4. Interpolation

Q Calculate Distance Using Field Calculator
® Calculate Distances Between X and (X; X, and X;)

£ P caleulis T

% Croate & new Sebd
Conatm vinunl ekl
Quputfeld name | distce
Oup S ps | Darimal rambar sl
Quputdeld lengh 10 (3 Precision |10

Upate auishag Nk

Esprassion | Funcion Edior

(1]
Duaut presdew: (1461 2GRN

32
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l11-4. Interpolation

O Calculate Distance Using Field Calculator
® Result

lll. Using QGIS

¥ temperatire - Features total 3, AMarec: 5, BIecien [ I
.B_II | & v 2o P A|RRE
123id - [
id High Low gdd distance )
150000000000
- 1T 25 O], [ X, = 29 J
47249 290000000000 160000000000 125000000000 47243, 3635524166 Xy = 25 o
1 g io}
JERET 16, 000000000~ &, 00000000y | 0. . o} Y Vs
g T . S A AN
| 414812057 § | X =7 | | 472493635 |
__________________ ~ Jetn TR
vt

l11-4. Interpolation

O Calculate Inverse Distance Weight Using Field Calculator

@ Open Field Calculator

@ Create a New Field “weight”

® Calculate weight > 1 / "distance" A2
@ Click "OK"

Il. Using QGIS

A P it ] i
i e -
Z w' (x)rt‘B L i:::l::’:\::::ll Wadate saisting field
=1 . . Oupu ik e skt
={x » ifd(x,x;) # 0 for all i bt
u(x
N R __
i=1 s ERre a—
Ui, if d(x,x;) = 0 for some % : E:.:;:m"
E .
where i
1 x"ﬁ?ﬁ?}F
w; (x) = pmmm———= C
1d(x, x; )7l
34
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l11-4. Interpolation

O Calculate w;(x)u; Using Field Calculator
@ Open Field Calculator
@ Create a New Field “wu”

3 Calculate weight > “weight” * “High”

lll. Using QGIS

7 Fec i
u(x) = o) £0foralls e s
if d(x,x;) = 0 for some %
where
1
wi(x) = d(x, x;)?
35
lll. Using QGIS
l11-4. Interpolation
O Calculate w;(x) Using Field Calculator
@ Click on the Right Upper Corner of the Attribute Table
@ Copy the Table (Ctrl + C)
® Open MS Excel and Paste (Ctrl + V)
.d lempem. Fea‘l:r;s total: 2, filtered: S‘ﬂ:ted:s @m l
GLEERIEEEEEEY P 2w
we_[-€) [ Ut | Uptoe S || o) = { " vy Hex) £ 0foralli
- ‘ ‘ : IR
m,_ if d(x, x;) = 0 for some i

36
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lll. Using QGIS
l11-4. Interpolation

Q Calculate Interpolated X Using Excel

@ Click on the Right Upper Corner of the Attribute Table
@ Copy the Table (Ctrl + C)

3 Open MS Excel and Paste (Ctrl + V)

A B C D E F G H 1 1 P P —

wiht_grom Hil ow stance we v [l H
]z p:ﬁ?lsuad 41481 " 35L 15 o 1064.1‘.5’5;04 "‘-Jgﬁrﬁ-ﬁ i :Zw, (%))
3 Point I'BS::‘ 47?49 ?‘3 16 125 472E+D4 :JEL ------ 1 ) 3
e ose et 15 4 u(x) = :'“ﬁ ------ P if d(x, x;) # 0 for all 4
. i Zwa(x) i
L] [ S J
2 up, if d(x,x;) = 0 for some i
11 where
13
14 1
i: wilx) = d(x,x;)?
37
lll. Using QGIS
l1I-4. Interpolation
Q Result
A B C D E F G H I
wkt_geom id High Low gdd distance weight  wu
Point (908 41481 25 15 10 4.15E+04 6.00E-10 1.50E-08
Point (987. 47249 29 16 125 4.72E+04 4.00E-10 1.16E-08
Point (966 38561 15 4 0 3.86E+04 7.00E-10 1.05E-08
‘ 1.70E-09 3.71E—08| 21.8235 |
; | X, = 29 |
¥ =25 o :
o - io}
Lo} _‘ Vs
N ga

38

QGIS Tutorial for Agrometeorological Practice | 27




National Institute of
Meteoralogical Sciences

Korea Metecrolegical
Administration

()

l11-4. Interpolation

Q Built-In Interpolation Tool
Raster = Interpolation = Interpolation
Select Vector Layer and Attribute

Click on "Add" Button

Select Interpolation Method > IDW

©® e 0 6

Click on "Set to current extent” Button

lll. Using QGIS

39

® Save
EEE T # intarpalatian ghigin =
Prapct Edl Wew Laer Sefings Bhigina Vechr [HeaWr| Datahie Wb MMOSE Progessing | =
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l11-4. Interpolation

Q Built-In Interpolation Tool
@ Result
@ Properties > Style > Render type(single band pseudocolor)

lll. Using QGIS
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llI-4. Interpolation

Q Built-In Interpolation Tool
® Check “Invert”

@ Click on "Classify” Button

® Click on "OK" Button

lll. Using QGIS
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l1I-4. Interpolation

Q Built-In Interpolation Tool
® Zoom-In
@ ldentify Feature

lll. Using QGIS

Click on Any Place on the Canvas :

Bl

= gannd 1
- [Derived)

Mode | Curent layer

View Tme  |x

* Ao openfam
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v

v

I1I-5. Modeling with Vector Grid

O Scenario

Chemicals leaked from a special vehicle that was carrying toxic substance.

This chemical is a colorless and odorless that diffuses into the air

lll. Using QGIS

It is not a problem if it is exposed to less than 11,900 nanograms, but exposed to more than

that, the exposed need to be examined.
Thus, the authority made the following request to you.

What is the range of areas exposed above 11,900 nanograms?

This tutorial is inspired by Barry Rowlingson’s online R workshop linked below.

Barry Rowlingson. 2012. Geospatial Data in R and Beyond. Available at: http://www.maths.lancs.ac.uk/~rowlings/Teaching/UseR

2012/plume.html

43

v

v

l1I-5. Modeling with Vector Grid

Q Object

Modeling a process using vector grid
Advanced use of field calculator
Visualization of a process

Presentation of deterministic model

f=aexp(—(d/)5’)2 e~k cos(6—0)? )

44

lll. Using QGIS
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lll. Using QGIS

l1I-5. Modeling with Vector Grid

Q Basic Information
v" When chemicals are diffused into the air at a certain point, chemical exposure in the area is

expressed as a function of the following.

f=aexp(—(d/f)2ekcos6-0?) ©

Leak
o o = Exposure level / A point “d” distance
o d = Distance from the release to a certain point away from the leak
o P = Distance scale factor point in the
o k = Eccentricity (=strength of the wind) direction of 0
o B = Wind direction
45
lll. Using QGIS

l1I-5. Modeling with Vector Grid

O Basic Information

v Information on the situation at the time of exposure was obtained below.

F=aexp(—{djp)2e o5@70?) ©

Leak
o o = Exposure level = 12,000 / A point “d” distance
o d=7? away from the leak
o B =400 point in the

o Kk = Eccentricity (=strength of the wind = 5) direction of ©
o B = Wind direction = North East = 45° (1/4pi)

46
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lll. Using QGIS

l1I-5. Modeling with Vector Grid
O How to Calculate the Distance between Two Points in Field Calculator
v “distance()” function : Returns the minimum distance between two geometries

- distance(geometry a, geometry b)

Example

distance( geomFromWKT('POINT(4 4)") , geomFromWKT('POINT(4 8)")) — returns 4

2
f=aexp(~(d}p)?ecos0-07)
47
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l1I-5. Modeling with Vector Grid

0 How to Calculate the Angle between Two Points in Field Calculator
v “atan2()” function : Returns the inverse tangent of dy/dx

- atan2(dy, dx)

atan2(v3, 1) = w3
n,vn

atand(l, 0) = w2
0,1)
+

f=aexp(~(d/p)*e* 8-

(1,0)

The limit of atan2 atan2(0, 1) =0
\ from this side is -n |

w1

[0.1)

Example
atan2(1.0, 1.732) — 0.523611477769969

48
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lll. Using QGIS

l1I-5. Modeling with Vector Grid

0 How to Calculate a Centroid of a Polygon in Field Calculator
v “centroid()” function : Returns the geometric center of a geometry

- centroid(geom)

Example
centroid($geometry) — returns geometry

49

lll. Using QGIS

l1I-5. Modeling with Vector Grid

O Procedure

@ Create a grid in the scope of analysis.

Initial Leak

12,000 nanograms

T
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QO Procedure

@ Fill each grid with a function result.

l1I-5. Modeling with Vector Grid

lll. Using QGIS

f=aexp(~(d/p

)2e~k cos(s—o)z)

Initial Leak pso

10,000

9,500

12,000 nanograms

T

1,500

11,000

10,000

11,500

10,500

51

O Procedure

® Adjust the color according to the function result.

l1I-5. Modeling with Vector Grid

lll. Using QGIS

52
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lll. Using QGIS

I1I-5. Modeling with Vector Grid

O Exercise

@ Add a leak point layer (release.shp) and a background map(EPSG=3857)

, .

Google Satellite can be imported by
Web - Openlayers Plugin - Google Maps

sl ol - Google Satellite

® @ releans

® Google Satellite
s [MEE] MMOGIS Progessing  Help

ac -

OpenLayers Dverview
et v bt |5 RS @ @ &

Ogisdtroris * |8 opsnarsasi N

® o . ey
Bing Maps " Googls Stroats
= MapQuest + | Googe Hybrd
3 osM/stamen v
[ Agple Miaps

v" Plugins can be installed from Plugins - Manage and Install Plugins ...

53

lll. Using QGIS

l1I-5. Modeling with Vector Grid

U Exercise

@ Add a Vector Grid and Save as grid.shp

# Vector grid

Grid mxtent

Update extants fom laver Updata axlerds from canvas
= Min | 14122911, 287 Wi | d510145, B205T
= Max | 141402931208 “ hvla | 4519608, 05466
Paramelers

= Lock 111 ratia

=
:: Dutput grid a5 polygend Fiottian anale in dearses

Dutput grid ag linas oo =

Ourpud shapaile
G N
® Add rasult fo canvas
i 3 0k
54
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lll. Using QGIS

I1I-5. Modeling with Vector Grid

O Exercise

® Capture the Coordinates of the Release
- Right Click on the “release” layer > Open Attribute Table > Click at the Top-Left Blank
- Copy by Ctrl+C > Paste in Excel Sheet

£ o e . -
Poiscl Bl Vow Lwwr Sifirge PFagine Wickr Barke Dofabace e & release = Features total: 1, filtered: 1

BROSE 1O s p AL 7 ’k:[ = [ = .
178 ant~so ams |/ B Point (14126029 4512152) |
Q. i
L] T
~
» A B
=Y Wk geam e ————— id
(-; :_Poi nt (14126029.15307043120265007 4512 152.5080350235957206): 1
@
M
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lll. Using QGIS

l1I-5. Modeling with Vector Grid

O Exercise

@ Distance between the Release Point and Each Grid Centroids -> Field Calculator on “grid” layer

® Create a new field Update existing fisld
Crasta vitusl field 1]
Ouiput field name  distance 0

| __distance
LR T

Oufpu field fype Dacimal number (real? - T TET BB

Oupid field length 10 = Preclsion |10 = o TBM eI

-

1

1

1

1

1

1

1
Expression | Function Ediice | 2 : 3| e 2T6TAREEEY
[ 70 L L 0 . Search q : DT E
diztncel tgeomatry. geam from_whil *Ecint (14126029 4512152) M 5~ Fuzzy Maiching 1 : 5| TeE1 ETITEISE

- G !

1

I

1

1

1

1

1

Ganeral 5
5 Gaomaty g B TEE TS
faraa

T 544, 1E38013457
B TEI SEIREMES
centraid 9 TEHL046RIBEAE
clozast_point

combing 3 10 TEAT ABI0ENS 6

“~ contains, ”]_ 1
-~ convex_hull " 3 1T TE TR
e ER I
- :ua T SHGIEBTT
"5 Show all anrLl.l, :::._v---
: R ; e *(d )2 —k cos(ﬁ—@]z)
distance( $geometry, geom_from_wkt( 'Point (14126029 4512152)") ‘ f=aexp(—(d/p)°e
56
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l1I-5. Modeling with Vector Grid

O Exercise

® Angle between the Release Point and Each Grid Centroids

& Figld caleulator
il

Only update [ selacied features
*® Create 3 new fisld Update axisting field
Crase rtual fisld
Output field name  =ngla
Owrpur field fype Dacimal number (real) -
Outpud fleld length [0 |5 Precision 10 =
E=pression | Funciion Editor |
= e ] e Zearch
atan Hymax{centrail iaecmetmy ) - I ., smaslzeniraid(Saeametry)) - |11 25029) . [ewe_number
- Conditionals
- Convarsions

- Cusiom

- Data and Time:

= Fields and Yalues
H- Fuzzy Maiching
= anard

=

Z
=

i

lll. Using QGIS

. gric . Features total E133z, Tiered. 81352, sAecied.
VLR AR ¢
122D -=g] e ———— N
0 [ distnce | anale i
- e AT B i
| T 7EIE] IR ==
1 1
= 2 TS TMEON | 1 BIEISELL |
I 1
3 3| TG BED |
. 4 T |
5 TG Rilla=z
i3 1 1
6 g TETTEE,
— 1
; 7 e e |
| 1
. § TR 1T i
= il :
o Rl R
1 'IT?B3|[||]'{_ H
1 TS g R ——— .

" T2

distance( $geometry, geom_from_wkt( 'Point (14126029 4512152)")) ‘

f=aexp(_(d/ﬁ)ze—k cos(ﬁ%@)z)
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l1I-5. Modeling with Vector Grid

O Exercise

® Calculating Exposure Level of Each Grid Cell

 Fiele caleulator
Only update Nseleciad faatures
*® Create a new field Update existing field
Crasta vitual field
Outpud field name | level
Quipd figld type
Outpud fleld lenoh 10

Dacimal number [raal -
2| Precision :
Expression | Funciion Edlior |

= e =l e e s

i | Foeaspl- (" a1 arance " 0) Peenpl-Gecos(manglen - pillf a2

12000*exp(-(("distance"/400) A 2*exp(-5*cos("angle" - pi()/4))*2)) ‘
58

lll. Using QGIS

A grd ote: 61932, filtered 61932, selectadt 0

ﬂ & E - - & :
D

[l diztance

5250 T T 3

m AR JMEIAN0000 . -1 SRy TTHO0 E2SCRaaEE
IE 4357 1T EIZ1090900 2 EEPETEI0IY 11438 FEEEI01353
m 43576 T CMEEDITTOO) 25440170711 T, 0000000000
a 43258 37367000000 ﬂ.?;l&ﬁz?li{ 11398, 200082313
m 4307 JTEETITHD -ﬂ.d-B?IﬂEE!?T} 11396, S0EE0d 7570
Hgn A Rl

23 iE i

s N T TR

7091 AT 5 AETEASEI0 ﬂ_@;l-lmﬂiﬂ# 11000, SeEERT0aE
T B T T 1o
m 45 BZA2I1355300 -|].9d2223?|]ﬂ"| | 0664, EPETdGd 16
m 43206 BTEIZI23300 2.913:9]|]|152L-_—'--___
e B BRI L

 f=aexp(~(d/B)re*cos0-07)
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lll. Using QGIS
I1I-5. Modeling with Vector Grid

O Exercise

@ Visualize Exposure Level of Each Grid Cell

- Right Click on “grid” Layer > Properties > Style > Graduated

= e
!-G‘:'En%:::_;_-l ______________________ -
Coumn 12 lavel ~ | & |
Symbl M Creng.
Legand Format | %1 - & Pracizion |0 = [ Tim
Mehod Color
et T 1
(] E CTTREER R O L
Clazses | Hisgram
|mm—m—————— "
Mods | Enual Inenal Ty Clmses M = Chedty
[Symbol "~ [Vahes | Legend I=
® - 500 T-510
*® S000-100000 500 - 1000
*® 100000 - 150000 1000 - 1510
* 150000 - 300000 1600 - 200 =
* A000- 29000 2000 - 2600 =
ddd class | | Dol | Delakall | Link cless boundarkes
Advercad -
e o e e e e e e e e e
Laer [ 52= =
Loyt e made e e e e e e e —— o =
Diaw afcts Y
Cantl featura mncaring cedar |
Syk - [ Cameel | | fany el
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lll. Using QGIS
l1I-5. Modeling with Vector Grid

U Exercise

Result
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lll. Using QGIS

I1I-5. Modeling with Vector Grid

O Exercise

@© Over 11,900 exposed areas > Select by expression

IPPRAAE @& E-s-aEEz=m-Cac @ @
iR sgs 88 ANGOD

Ewasion | Function Ediar

e e

Leweln 3o |

Laaing badvakues e WFS lapers

aluss

ank you
Q&A
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Exercise 1 — Calculation of GDD from the digital map of temperature

Objectives: The goal of the first exercise for Agro—meteorology is to generate the
digital map of growing degree day (GDD) from the digital map of temperature. In order
to create the digital map of temperature, we first need to join CSV/Text file which has
temperature information (i.e., maximum temperature or minimum temperature) to vector
data (i.e., shape file) having coordination such as latitude and longitudes and interpolate.
In particular, we need the base temperature to calculate GDD of crops; in case of rice, a

summer crop, it starts growing at 10 Celsius degree.

1. Open the weather shape file. You can open the shape file from two ways. First one is
using the menu and the other one is just adding layers from “Drag and Drop from
Window Explorer” (see Note 1, Fig. 3).

- go to the file menu “Layer” >> click “Add Layer” >> select “Add Vector Layer”
(Fig. 1)
- click “Browse” button in ‘Add vector layer’ box and find the shape file: (Fig.2)
file location: QGIS Tutorial — Data — Tutorial Session 2 — ASOS Observation:

kma_asosb58.shp

£ Gt 2148 Essen
Praper 0t ew Lover Senrgs F
AR

o

BErafs8YNANS

Thara i3 a now QS version avaable ¥t mmpc/downioed 0ps. 000 10 Gt Vour coay of varsion 2.16.0
Coordnste & o [ 34787 196 < Rotaion |00 < o] Porder QUEPSGANE @

Fig. 1.
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Fig. 2.

Romter 0.0 = |7 Renoer QEPSGATE @

Note 1: the way of “Drag and Drop”

Drag a shape file from the Windows Explorer and drop it on the ‘Layers Panel’.

&
TEERR Q- EET -
2B q - o - | 4 0 = ASOS Chsenvation - o x
- Prevaer Pand ' —EEl = x w o —
o - i
Farie - « 4 1 - Tutorsl Se. » ASDS Cbservation v B | ASDS Obnervation 34 r
O |5 [ Home
} Favauries b1 B A o :
By BCY o
» | PmEsic W TEAL £ ] kma_asos58 dbf
a -:'O:,;c 284 o ma_assS2pg
5 B i e 4E * Y b
£ Sopstisl e krnaa_arsis S8 shn
B Sows Tutorisl Session 2 krra_arsins 58 sk
M| @wes BEAY | kena_ssos58.shp
/ 0 wes -
‘la s 3 ES kra_ases5Bshp
v ki arsers SB.shx
= & samsung ek 03 m3avy 03110
& Onelrive 0% m3lava w110
L 1R
‘Leyers Panel o #uEys
AnYi-840
42 1F
v € >
O BE 17 WS MEE LAk —=F
B
1 o SRS RO 200 Cooronwe] 163 0NN B Sode 12

5| Renor QUSR 0000 @

Fig. 3.

2. Open the text file which has the monthly maximum temperature of Normal (1981-
2010).

go to file menu “Layer” >> click “Add Layer® >> Select “Add Delimited Text Layer”
(Fig. 4)

44 | QGIS Tutorial for Agrometeorological Practice



- click “Browse” button in ‘Create a Layer from a Delimited Text File’ box and find

the text file. In addition, should select the options of ‘CSV’ and ‘No geometry’ (Fig.

5)

- file location: QGIS Tutorial — Data — Tutorial Session 2 — ASOS Observation:
m30avg_tx8110.csv
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Fig. 4.
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Fig. 5.

3. In order to Join the text file to the vector. First of all, select ‘kma_asos58.shp’ on the
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‘Layers Panel” and click the right button of Mouse to open properties box.

- click the right button of Mouse and select “Properties” (Fig. 6)

- click the ‘Joins’ tab in the left contents’ list of ‘Layer Properties — kma_asosb8&’

box (Fig. 7)
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Fig. 7.

4. Select the icon (cross symbol) in the ‘Lay properties — kma_asosb8’ box and
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you set up configurations to join the two files in ‘Add vector join’ box as below (Fig.

8).

- Join layer: m30avg_tx8110

- Join field: SCODE

- Target field: SCODE

- if you want to choose which fields are joined: you click combo box ‘Choose which
fields are joined’ and you can select fields you want to join

- additionally, we need to make prefix to avoid the long name of field. So, click
‘Custom field name prefix’ and input the text what you want to be shown for the

field. For this exercise, we input the prefix ‘M30_’ as figure 8.
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- you can check by opening the attribute table: Select ‘kma_asosb8.shp’ on the
‘Layers Panel’ and click the right button of Mouse, then click ‘Open Attribute
Table’ (Fig. 9 and Fig. 10).
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5. Save the vector file which have the temperature information by using ‘Save as’.
- select ‘kma_asos58.shp’ and click the right button of Mouse, and then click ‘Save
as’ (Fig. 11)
- select the button ‘Browse’ in ‘Save vector layer as’ and type in the file name. We
will type in ‘m30_tx8100’ to the folder ‘exercise’ (Fig. 12)

- file location: QGIS Tutorial — exercise
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- You do not need to change any other configurations and just click the button ‘OK’.
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Fig. 12.

Open the saved vector file at the step 5.

- go to the file menu “Layer” >> click “Add Layer” >> select “Add Vector Layer”

- file QGIS Tutorial -
m30_tx8110.shp

location: Data — Tutorial Session 2 - exercise:
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- this shape file would be that you saved at the step 5. (Fig. 13)
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7. We will interpolate with the temperature information. First, go to the menu ‘Raster’
and click ‘Interpolation’ and then click again “Interpolation” at the extended pull-

down menu (Fig. 14).
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Fig. 14.

8. Set up the configurations as below (Fig. 15):
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- first, look at ‘Input’ panel in the left of ‘Interpolation plugin’ box, then

- click the combo box at ‘Vector layers’ and choose ‘m30_tx8110’

- again click the combo box at ‘Interpolation attribute’ and choose ‘M30_TX01’

- click the button ‘Add’ to input the selected field to the text box

- look at ‘Output’ panel in the right of ‘Interpolation plugin’ box,

- select ‘Inverse Distance Weighting IDW)’ in ‘Interpolation method’

- type in ‘400’ for ‘Number of columns’ and ‘427" for ‘Number of rows’,
respectively.

- we need to setup extent of map, type in X min and Y min, respectively: 51832.3
for X min,~33145 for Y min

- additionally, 546767.24 for X max, 569052.49 for Y max
(see Extent_Interpolation.txt file in DATA — Tutorial Session 2 folder)

- type in ‘m30_tx01’ in the folder ‘exercise’ to save the interpolation.

- file location: QGIS Tutorial — Data — Tutorial Session 2 - exercise (Fig. 15)
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Fig. 15.
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9. You can make interpolation from February to December

- file names for saving: m30_tx02 ~ m30_tx12

10. Likewise, you open the text file which has the minimum temperature and the shape
file. You interpolate then them. Remember from the step 2 to 9. So, you can have
24 digital temperature maps to calculate GDD of crop.
- file location to open the text file: QGIS Tutorial — Data — Tutorial Session 2 -
ASOS Observation: m30avg_tn8110.csv
- file location to open the shape file: QGIS Tutorial — Data — Tutorial Session 2 -
ASOS Observation: kma_asos58.shp
- file location and file name to save the vector file joined with the minimum
temperature: QGIS Tutorial — Data - Tutorial Session 2 - exercise:
m30_tn8110.shp

— then, save the interpolations as those filenames: m30_tnO1 ~ m30_tnl2

11. Now, you can calculate GDD by using ‘Raster calculator’ if you have 24 digital
temperature maps. Go to the menu ‘Raster Calculation” and open ‘Raster calculator’

box. (Fig. 17 and Fig. 18)

We will GDD equation as below (Kim et a/., 2008):

T,—T
GDD=NX[(¥>—TD+LXUX\/N

N: the number of month, 7% the maximum temperature, 7, the minimum
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temperature, 7» the base temperature of crop, L: constant, o: the standard

deviation of the average temperature

You can refer Thom (1954) since the constant L was calculated from that.

- should open the raster, constant L. and standard deviation:
file location to open the raster, constant L: QGIS Tutorial — GDD — Constant L:
m30_L01 ~ m30_L12
file location to open the raster, standard deviation of the average temperature:
QGIS Tutorial — GDD - SD Tavg: m30_ta_sd01 ~ m30_ta_sd12

- type in equitation for January GDD as below, click operators as well (Fig. 17),
31 = ( ( "m30_tx01@1" + "m30_tn0Ol@1" ) / 2 ) - 10 + "m30_L@1" =
"m30_ta_sd01@1" * sqrt ( 31)

- click the button “...” of ‘Output layer’ in ‘Result layer’

- file location and file name to save the calculated GDD: QGIS Tutorial — Data —
Tutorial Session 2 — exercise: m30_gdd0O1

- just check ‘GeoTIFF’ of ‘Output format’
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Fig. 18.

12. You calculate the rest of GDDs from February to December
- file location and file names to save the results from February to December: QGIS

Tutorial — Data — Tutorial Session 2 — exercise: m30_gdd02 ~ m30_gdd12

13. Then, accumulate 12 GDDs from January to December, or 10 GDDs from January to

October.
- type in equation: "m30_gdd01@1" + "m30_gdd02@1" + "m30_gdd03@1" +

"m30_gdd04@1" + "m30_gdd05@1" + "m30_gddO7@1" + "m30_gddO8@1" +
"m30_gdd09@1" + "m30_gdd10@1" + "m30_gdd11@1" + "m30_gdd12@1"

- click the button ¢...” of ‘Output layer’ in ‘Result layer’

— file location and file name to save the accumulated all GDDs: QGIS Tutorial — Data

— Tutorial Session 2 — exercise: m30_tb10_gdd_tiff
14. Convert the GeoTIFF to ASCII

- go to the menu “Raster” >> click “Conversion” >> click “Translate (Convert

Format...)” (Fig. 19)
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- if you want to translate the files are not in ‘Layers Panel’, can click the button
‘Select’ in ‘Translate (Convert format)’ box.

- but, we will translate the file which already opened in ‘Layers Panel’, so just click
the combo box and click ‘m30_tb10_gdd_tiff* (Fig. 20).

- select the format ‘Arc/Info ASCII Grid (+.asc *.ASC)’ in the list and type in the file
name to save (Fig. 20).

- if finish type in the file name, do not change any options, and click ‘OK".
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Fig. 20.
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- when finish conversion, the popup boxes ‘Finished’ and ‘qgis—ltr—bin’ will be shown,

click ‘OK’ and ‘OK’ in order, and just click ‘Close’ (Fig. 21).
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Exercise 2 — Exploration of the areas which reach to the effective GDD

Objectives: In the second exercise for Agrometeorology, we will explore the effective
GDD of the crop. For example, we can find the pixels which reach to the flowering or
the maturity time from the effective GDD of the crop. We already calculated the GDD of
rice. When the growth of rice reaches the maturity, the range of the effective GDD at
the base temperature 10°C is known as from 3800°C to 4800°C. Find the pixels that
reach to the effective GDD of crop ‘Rice’.

1. Open the accumulated GDD ‘m30_tb10_gdd’and open ‘Raster calculator’ as well.
- file location to open raster file: QGIS Tutorial — Data - Tutorial Session 2 —
exercise: m30_tb10_gdd
— this raster file, m30_tb10_gdd would be that you saved at the step 14 in excise 1.

2. Go to the menu ‘Raster calculator” and type in the equation.
- type in the box as below: (Fig. 22)
("m30_th10_gdd@1" >= 3800.0 AND "m30_tbl10O_gdd@1" <= 4800.0) =
"m30_tb10_gdd@1"
- file location to save the result: QGIS Tutorial — Data — Tutorial Session 2 —

exercise: rice_gdd

¥ Raster calculator ? X
Raster bands Result layer
mi0_Lo1@1 A Output layer BI/DATA/Tutonal Session 2/exercise/nce_gda l:l
m30_Lo2eEn
m30.L03@" Ourtput format GeoTIFF E
m30_Lod@1
m30_LOG@EH Current layver extent
m30_Lo6@N
m30_L0T@! X min 143309.00000 : HMea |544832.00000 ;
m30_LOG@1 L e © e i
m30_Lo9@n ¥ min 99808, 60000 v ¥ max |526697.00750 e
m30_L10@1 - : x = =
mI0_L11@1 Columns 400 - Rows (427 -
m30_L12@1 Output CAS Selected CRS (USER:100000, » Generated CRS (sproj » &
m30_gdd0 1@
m30_ta_sd01@1
M30_ta Gr‘\')'?:"oc;\l < Add result to project

» Operators

+ - sart cos 3in tan log10 (
i/ 2 acos asin atan In )
< * = I= {= = ARD OR

Raster calculator expression

("m30_b10_gdd@1" >= 3200 AND "m30_b10_gdd@1" <= 3800) = "m30_b10_gdd@ 1"

Expression vaid
Ok Cancel

Fig. 22.
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Exercise 3 — Presentation of layout GDD

Objectives: We will make presentation with your results in the last exercise. First,

change legend and color scheme using ‘Style layer’ in properties of the raster, and then

make layout from “Map composer” (you already practiced at Introduction part of QGIS -

day I (7 December)).

1. Select the raster file, ‘m30_tb10_gdd’ in ‘Layers Panel’, click the right button of

Mouse and ‘Properties’ (Fig. 23).

- click ‘Style’ in ‘Layer Properties — m30_tbh10_gdd’ box.

- click ‘Singleband pseudocolor’ of ‘Render type’ in the combo box.

- select ‘Classify’ of ‘Generate new color map’ in the right.

- 1if you change mode of classification, there two modes ‘Continuous’ and ‘Equal

Interval’.

- let’s change ‘Continuous’ to ‘Equal Interval’, then change 5 to 8 in Classes.

- lastly, select ‘Apply’ and ‘OK’.

/ Layer Properties - m30_gdd01 | Style ? X
) A
¥ Band rendering
Render type | Singleband pseudocolor -
Band Band 1 (Gray) ~| @Generate new color map
Color interpolation | Linear - - Edit [ Invert
(=)
gp| =] ¥ & | Mode Contnuous  ~ Classes 5 =
Value Colo Label | Max (75,8942 |
-103.0-- I - 103.033000 -
-58,30 -58,305700 Classify |
-13.57 -13.572400
3116 31.160900 ) )
75.89- [ 75.894200 Estimated cumulative cut of full extent.
Load min/max values
- %
standard dewviation »
Accuracy
(@ Estmate (faster)
O Actual (slower)
Load
] clip
v Color rendering
Blending mode  Normal © © Reset
Erightness B | Contrast B
Saturation B [ Grayscale |Off -
Hue ] Colarize [~ Strenath 100% =
¥ Resampling
Zoomed: in |Nearest neighbour = out [Nearest neighbour  ~ Oversampling v
Style - oK Cancel Apply Help

Fig. 23.
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- you can see the color legend of the raster, ‘m30_t b10_gdd’ in ‘Layers Panel’ (Fig.

24).

- if you want to overlap a vector has the administration boundary, open the vector,
‘Ws_Sido.shp’ (Fig. 25).
- file location: QGIS Tutorial — Data — Tutorial Session 2 — ASOS Observation:
WS_sido.shp
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Fig. 25.
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2. Go to the menu ‘Project’ and select ‘Composer manager’ (Fig. 26).

Click ‘ADD’ button in ‘Composer manager’, and in order to create map, type in the

name of map: Rice_GDD in ‘Composer title’ box and click ‘OK’ (Fig. 27 and Fig.

28)

14 8-Ean

- o X
Edit Wiew Layer Semngs Plugins Vectr Raster Database Web Processing Help
T New wlebl . @ oo om O O ~ T o o = e
Oen.. Culeo OS2 RNPPLARAR Q- -FH-&-FNEY =-0 g - @
New From Template L ST e w -
Open Recent O e e S (e e - >
| B Save Cules Piocnasing Tooux CiEs
| Save As... ClShieS pown
By Savo as Imago.,, o Facary vrad algohE
DiF Export.,. Rirster calculalor
B Projwct Propetios...  CylsShip Fleclassify values (simple)
boiutli b . i J GOAL/OGH (47 peoalgorithms]
Hew Print Composer _ Cul+# i g GAASE GIS T commands [ 159 geoalgart
# of Models [0 geoalgorithms]
Print Comonaers. . w F OGIS geoalgarithms [107 geoalgarithma)
o G SAGA (2 1.2) [29 gecalgaritims]
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@ &
1 | g wes
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@
L]
@ a
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Y S-@

o~ A0 gd -
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Fig. 26.
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/. Composer title ? X

Create unique print cormposer title
(title generated if left ernpty) -

w [ew from te |Hice_GDDI |" i

Empty compao m Cancel il

Open termplate directory user default
[ Show ] [ Duplicate l [ Rermove ] [ Rename Close
Fig. 28.

- You can see a new window ‘Rice_GDD’ (Fig. 29).

#

Project Edit §** -
# Rk GOD

o x
Compnsor Edit View Layout ASas  Setings |
> : . % . e N s N & it =
r J H (] QX ﬂ - B e B Hepppa 58 8 1B E e | i ¥ -
v T T - T e [ < PP B Ff, || e | Command histoy | LS
(+] Hema =
¥ A E |Iiu|-| I
T
@ ‘ - Composiion | hem properies | Aflas gemeration
- it x Men proparties t3
n|e 1
5] -
o a | x
% L
& "
Vo 2
# B
i % M men v Omm page! | B -
e B T TS
¥ P it . wiess, Luloze]

Coordinate 257089 405003 B Scale  ZEEE w Rotwion 00 % s Fender QPEPSESEIMOTR &

go to the menu ‘Layout’ and click ‘Add Map’ in the pull-down menu (Fig. 30).

you can check the figure of mouse pointer ‘+’ (cross). So, you drag the box in the

white box, then the map will be shown (Fig. 31).

in addition, you can make other components of map, in instance legend, scale-bar,

and labels such as text (Fig. 32).
- click ‘Add Scalebar’ and drag the box to make scalebar.

- click ‘Add Legend’ and drag the box to make legend.
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Fig. 31.
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Fig. 32.

- let’s make the title of map. Go to the menu ‘Layout’ and click ‘Add Label’, then
drag the box at top of the layout (Fig. 33).

# Rice GDD - 0 X
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Fig. 33.

- click the tab ‘Items’ in the right panel and click ‘QGIS’ (Fig. 34).

- click the tab ‘Items properties’ and the black triangle toggle symbol of ‘Label’ to
spread ‘Main properties’ box and type in the title: Rice GDD: >= 4800, <= 4200
Celsius degree (Fig. 34).

- click the toggle to expand of ‘Appearance’ and click the button ‘Font’ (Fig. 35).
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- change the size of font as 36 in ‘Select Font’ box (Fig. 36).

- click the option ‘Center’ for ‘Horizontal alignment’ and click the option ‘Middle’

for ‘Vertical alignment’ (Fig. 37).

- now, finish making the map layout (Fig. 38). If you want to make image, or PDF

etc, go to the menu ‘Composer’ and click ‘Export as Image...” or ‘Export as PDF...”

(Fig. 39).
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Note 2:
TM coordination in QGIS: EPSG:5174
WGS 84 in QGIS: EPSG:4326

66 | QGIS Tutorial for Agrometeorological Practice



